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To learn more about the Milestones window choose: Help | Help Topics. 
Select the Index tab and type in the feature. For Example Toolbox. 
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CHOOSE THE                TAB TO: DATES  

1. Set the schedule’s Date Range. 

2. Set Page by Page Date Range. 

3. Set options for Fiscal Year. 

4. Set Saturday, Sunday and Holiday Shading. 

5. Set the schedule’ Holiday Calendar. 

6. Current Date from computer or choose to override. 

7. Display the Current Date. 

8. Display the Current Date Line. 

9. Display the Status Line. 

10. Change Date and Status Line attributes -  More current date options. 

11. Have Symbols & Bars Fill to Status Date  

12. Choose Four-Digit Years. 

13. Set the Symbol Date Format. 

14. Set the schedule’s Date Headings. 

Make sure to press the APPLY buttons after entering 
the parameters for the schedule. 

Choose the       Full Dialog 
button to find more options 
for a feature. 
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To learn more about the tab features choose: Help | Help Topics | Milestones Professional Help 
Select the Index tab and type in the feature. For Example Baseline. 

1. Set the Chart Size. 

2. Set the  Margins. 

3.  Eliminate Automatic Top Margin. 

4. Set the Rows Per Page. 

5. Set the Orientation. 

6. Set the Legend Height. 

7. Set the three possible DataGraph heights. 

8. Setup Summary Bars. 

9. Setup Baseline. 

10.Set Duration options. 

11.Global Symbol Size change. Make sure to press the APPLY buttons after 
entering the parameters for the schedule. 

Choose the       Full Dialog button to find more op-
tions for a feature. 

CHOOSE THE TAB TO: LAYOUT  
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CHOOSE THE TAB TO: 

1. Insert a Chart Title. 8. Insert a Legend Entry. 

2. Insert a Page. 9. Insert a Vertical Links. 

3. Insert a Page Break. 10.Insert a Recurring Tasks. 

4. Insert a Task Row. 11.Insert a Baseline. 

5. Insert multiple Task Rows. 12.Insert a DataGraph. 

6. Insert a New Column. 13.Insert a ValueSet. 

7. Insert a Picture.  

Some of the features on the Insert menu are advanced 
features you may not use in the first schedules you 
build.  However, knowing the location of these fea-
tures will help you as you become a Milestones Pro-
fessional power user. 

INSERT  
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CHOOSE THE       TAB TO: 

1. Apply a Color Theme. 7. Change Background Color, Border, Frame Corners. 

2. Add Vertical Gridlines. 8. Clear Shadows, Highlights. 

3. Add Horizontal Gridlines. 9. Change Symbol Size.  

4. Add Curtains. 10. Set International Number and Currency. 

5. Add Holiday Shading. 11. Set-up Gridlines, Shading, Font Sizes by Outline Level. 

6. Change Default Text.  

FORMAT 

11. Assign features to tasks based on their outline level using the 
option:  GRIDLINE, SHADING, FONT SIZES BY OUTLINE LEVEL. 
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Plus Tool  - Use to add  
information to the schedule. 

Arrow Tool - Use to  select, change  or move 
objects on the schedule. 

Text Tool - Use to add text  
anywhere on the schedule. 

Drawing Tools - Use to draw lines, 
circles or squares. 

Symbol - select to add to 
schedule. 

Vertical Link - select to add 
between symbols on different 
task rows. 

Small Plus-  Select to add the cor-
responding  symbol, bar, symbol 
combination to the schedule. 

Horizontal Bar - select to add between 
symbols on the schedule. 

Double click any Symbol, Horizontal Bar or Vertical Link in the toolbox to change its charac-
teristics: (Shape, Type, Size, Color, Markings, Position, Text and Date display). 

Right click the TOOLBOX to 
change its characteristics. 

Set-up a row in the toolbox that then can be cop-
ied and pasted to another row in the toolbox or 
another schedule’s toolbox. Both schedules must 
be opened  in the same instance of Milestones. 

Set up a toolbox to your standards . Then copy and 
paste it to another schedule.  Both schedules must 
be opened  in the same instance of Milestones. 
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Add a Horizontal Bar With a Start and End Symbol 

1. In the toolbox, select the Small Plus at 
the beginning of a row.  The entire row in 
the toolbox will be highlighted in blue. 

2. Move the cursor to the schedule area.   

3. Click on the start date and drag horizontally.   

4. Release the mouse button on the end date. 

Add a Single Symbol 

1. In the toolbox, select the Large Plus tool. 

2. Select a symbol in the toolbox. 

3. Move the cursor to the schedule area .   

4. Click and drag horizontally.   

5. Let go of the mouse button at the selected symbol date. 

Add a Horizontal Bar  

1. In the toolbox, select the Small Plus at 
the beginning of a row with null symbols 
and a horizontal bar.  The entire row in 
the toolbox will be highlighted in blue. 

2. Move the cursor to the schedule area.   

3. Click on the start date and drag horizontally.   

4. Release the mouse button on the end date. 

Add a Bar and Symbol to an Already Existing Symbol in the Schedule 

1. In the toolbox, select the Large Plus 
tool. 

2. Select a symbol in the toolbox.  

3. Select a connector in the toolbox. 

4. Move the cursor to the schedule area and 
click on the already existing symbol. 

5. Continue to hold the mouse button and 
drag horizontally.   

6. Let go of the mouse button at the desired date. 

To see the date next to the cursor, Tooltips in the Schedule area need to be 
turned on. Tool | Help| uncheck No Tooltips in the Schedule area  

To set up a horizontal bar in the toolbox. Set the symbols on the right and left side of a toolbox row to Symbol Shape 28 (null 
symbol).  For the bar in the center bar us Bar Type 2, 5 or 7.  
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Add a Vertical Link Between Symbols 
1. In the toolbox, select the large Plus tool. 

2. In the schedule area, click once on the 
symbol from which you want the horizon-
tal to begin. 

3. In the toolbox, click once on the Vertical 
Link to be used. 

4. In the schedule area, click once on the symbol which completes the 
vertical link.  (Must be on a lower or higher row) 

Add Column Text (1) 
1. In the toolbox, select the Text 

tool. 

2. Click in the column or column 
heading box on the schedule and 
start to type. 

Add Symbol Text (2) 
1. With the arrow tool, click the symbol on the schedule. The toolbar will 

change to the Selection tab. 

2. Choose the Text tab. 

3. In the Text section, enter up to 3 lines of text in the Text Line 1, 2, or 3. 

Add Freeform Text (3) 
1. In the toolbox, select the Text tool:  

2. Click anywhere on the schedule and 
start to type. 

3. Select the freeform text.  In the 
toolbar make changes to its attrib-
utes. 

Add Symbol Notes (4) 
1. With the arrow tool, click the symbol 

on the schedule. The toolbar will 
change to the Selection tab. 

2. Choose the Notes tab. 

3. In the Symbol Note section, type in 
your notes. 

4. Click the Apply Text Changes button. 

5. Select from the variety of formatting options. 

6. Use the directional pad to reposition the symbol note or the arrow tool to drag 
the symbol note to a location. 

Add a Horizontal Bar Between Two Symbols Already on the Schedule 

1. In the toolbox, select the Large Plus tool. 

2. In the schedule area, click once on the Sym-
bol from which you want the horizontal bar 
to begin. 

3. In the toolbox, click once on the Horizontal 
Bar to be used. 

4. In the schedule area, click once on the Sym-
bol which completes the horizontal link. 

4. Click the APPLY TEXT CHANGES button. 

5. In the TEXT PLACEMENT section, select 
the positioning of the text. 
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Change a Symbol on the Schedule 
1. In the toolbox, select the Arrow tool.   

2. In the schedule area, click once on a Symbol that 
you want to change. 

3. In the toolbox, click once on a different Symbol. 

Change a Bar on the schedule 
1. In the toolbox, select the Arrow tool.   

2. In the schedule area, click once on the Symbol 
that begins the Horizontal Bar you want to 
change. 

3. In the toolbox, click once on a different Horizon-
tal Bar. 

Change a Vertical Link on the schedule 
1. In the toolbox, select the Arrow tool.   

2. In the schedule area, click once on the Sym-
bol atop the Vertical link that you want to 
change. 

3. In the toolbox, click once on a different verti-
cal Link. 

On the Schedule Change any Individual Symbol’s Properties 
1. Using the arrow tool, in the toolbox select the symbol. 

2. The toolbar will change to the Selection tab for that 
symbol select the tabs to change its attributes. 

3. Select the Text tab to change the text size, color, font, 
date format and/or the position of the text or date. 

4. Select the Size/Color tab to change the symbol’s color, 
size, vertical position on the task row. 

5. Select the Summary/Mark tab to change the Symbol Mark and its color. 

6. Select the Notes tab to add notes to the symbol and change the characteristics of the note. 

7. Select Hyperlinks tab to add URL’S or link files to the symbol. 

8. Select Constraints tab to add specific actions to the symbol like, lock symbol to this date. 

9. Select Symbol Links tab to add links between symbols on current schedule, another schedule or a task in a Microsoft Project file. 

10. Select the ValuesSets tab to add a value to the symbol for Symbol ValueSet Datagraph  

11.Select the Vertical Links tab to override the vertical links color. 

Using the shift key you can select a 
group of symbols to change. 
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Move a Column 
1. In the toolbox, select the Arrow tool. 

2. Move the cursor to the top of the column heading's border. The cursor changes 
to the Column Move cursor.  

3. Click and drag to the new location, as shown by the Insertion cursor. 

Change an Existing Column’s Type 
1. In the toolbox, select the Arrow tool. 

2. Click the column heading of the column you want to change. The 
toolbar will changes to the Selection tab. 

3. Click the Switch to Column icon.   

4. In the Column Type and Format section choose the down arrow 
next to the Properties button.  Pick from the available column types. 

Override the Color of a Bar on the Schedule  
1. Using the arrow tool, in the toolbox select the starting 

symbol of symbol, bar, symbol combination on the sched-
ule. The toolbar will change to the Selection tab for the 
starting symbol. 

2. Select the Size/Color tab.  

3. In the Override Symbol and Bars Colors section click on 
the rectangle box next to 1st Bar Color to display the 
color pallet. 

4. Choose the new color. 

Override the Color and or Line Type of a Vertical Link on the Schedule  
1. Using the arrow tool, in the toolbox select the starting sym-

bol of the vertical link.  The toolbar will change to the Se-
lection tab for the starting symbol. 

2. Select the Vertical Links tab.  

3. In the Vertical Links from the Current Symbol 
section find the link to be changed. Each symbol 
can have up to five vertical links. 

4. Choose the new color and/ or line pattern. 

Override the percent complete of a symbol, bar 
symbol combination 
1. Using the arrow tool, in the toolbox select the starting 

symbol of the symbol, bar, symbol combination.  The 
toolbar will change to the Selection tab for the starting 
symbol. 

2. Select the Size/Color tab.  

3. In the Override Symbol and Bars Colors section 
choose the drop down next to the 1st bar Fill %. 

4.  Select a new percent. 
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Hide/Show All Symbol Dates and/or Text 
1. On the toolbar, click the View tab. 

2. In the Other section, click Override Symbol Text and Symbol Date Display . 

Shift all Dates by a Number of days 
1. On the toolbar, click the Dates tab. 

2. In the Date Range Tools section click the Shift all task dates icon. 

3. Enter the number of days. Choose Forward or Backward. 

CONVERT SYMBOL TEXT TO SYMBOL NOTES 
1. On the Format tab choose Symbol Notes to first set up symbol notes’ default 

settings.  

2. Choose the Tools tab.  In the Other Tools section, choose Convert symbol Text 
to Note Text... 

3. Select symbols to convert. 

4. Select how to convert. 
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CHOOSE THE TAB TO: CONNECTIONS  

1. Copy Metafile (picture) to the Clipboard 
Milestones is placed into another application as a picture. 

2. Copy Schedule to the Clipboard 
Milestones is placed into another application as a picture, 
text or  object (can be linked and will update when the ac-
tual Milestone file is changed). 

10. Copy all Pages to PowerPoint 
Picture of multiple page Milestones schedules will be cop-
ied into an already existing or new PowerPoint document. 

11. Copy PowerPoint Slides from Project 
The Project to Milestones Wizard will open. The Mile-
stones Professional schedule is generated. It will be copied 
to PowerPoint. 

3. Create Report from Project  
The Project to Milestones Wizard will open.  Step through the 
wizard. A Milestones Professional schedule will be generated.  

4. Create Report from Project Server 
Open Project Server then  choose this option The Project to 
Milestones Wizard will open.  Step through the wizard. A Mile-
stones Professional schedule will be generated. 

5. Refresh Previously Imported Project  
Refresh a file imported from, or tagged to, a Microsoft Project 
or Microsoft Project server file or files. 
Build a refresh list for a Milestones files tagged to multiple 
Microsoft Project  or Microsoft Project Server files. 

6. Refresh Highlighting 
Refreshed schedules can have the change symbols  highlight-
ed . Select this option to turn off the highlighting. 

7. Save Custom Project Template  
Choose this option to save a customized Milestones Profes-
sional schedule to have it included in the import wizard.  

8. Manage Custom Project Templates 
Choose this option to view and manage all your Custom Pro-
ject Templates.   

9. Export to Project 
Choose this option to  create a Microsoft Project schedule 
from a Milestones Professional schedule.   

Learn More: Help |Help Topics choose the 
Index tab type in keyword Microsoft Project. 
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14. Internet Publishing Wizard 
Choose to create schedule graphics and HTML pages-
ready for your web site. 
 
If your schedule has links to other schedules or docu-
ments hotspots will be created. Also, any Milestones 
schedules that are linked will also be published as HTML 
pages. 

12. Import Outlook Tasks or Calendar 
The Outlook information is imported into a set Milestones 
templates which can be modified after the import. 

13. Export Tasks to Outlook 
Pick the column of information from your Milestones 
schedule to import as the description for the dates that 
will be placed into your Outlook Task List. 

15. Export Schedule to XML file  
Choose from a variety of export options. 

16. Import Schedule to XML file  
Generate a schedule from a Primavera saved  XML:MS 
Project schema file with the XML Project to Milestones 
Import Wizard. 
Choose from other XML import options. 

If your schedule is outlined, you can create a set of 
HTML pages called a “tiered hierarchy” 
with multiple HTML pages for each outline level. 
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1. New 
Choose New Empty Schedule to 
open the blank default tem-
plate. 
Chose Clone Current Schedule 
to create a new schedule from 
an existing schedule.  

2. Wizard 
Guides you through setting 
up a schedule using  Step 
by Step or a Predesigned 
Template. 

3. Open 
Choose to open an ex-
isting Chart, Sample 
Chart, or Lesson Chart 
(associated with the tuto-
rials available on the Help 
tab). 
Choose to open a Tem-
plate over currently 
opened schedule.  Stand-
ard templates have been 
predesigned.  Personal 
Templates are ones you 
design. 
Chat to Merge open another chart to have it import into the 
bottom of the current opened schedule, best if chart for-
mats are the same. 
Open a Microsoft Project File to have the import wizard 
start-up.  Learn more about the Microsoft Project to Mile-
stones Wizard under HelpHelp Topics. 

4. Open a Recently Used File 
Choose from the list of 
previously used files. 
You can chose to edit the 
list by selecting Edit this 
list. 
This is the list that ap-
pears in the Milestones 
Professional Startup Choices dialog box. 

6. Save As  
Choose to save as a 
Chart, Template, 
or Microsoft Pro-
ject Custom Import 
Template 
(Schedule must 
have originated 
from the Microsoft 
Project to Mile-
stones Wizard 
Learn more about 
the wizard under 
the Help /Help Topics). 
Save as PDF for easy sharing of your schedule. 
Save as HTML to have the Internet Publishing Wizard start-
up. Learn more about the wizard under Help | Help Topics. 

7. Save As PDF 
Save as PDF for easy sharing of 
your schedule. 

8. Import and Export options  
Choose from a variety of import and export options.  Learn 
more about these under Help | Help Topics. 

5. Password 
Apply up to a 20 character password to lock a file or to allow 
the file to be opened as Read-Only without the password. 

CHOOSE THE TAB TO: FILE  
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9. Master Schedule  
Choose to combine multiple Milestones schedules. 

10. Update Master Schedule, Linked Symbols 
Choose Master Schedule to update a Master Schedule with 
lower level schedules. 
 
Symbols can be linked between Milestones charts. To have 
linked symbols update choose Linked Symbols.  Learn more 
about linked symbols under Help | Help Topics. 

11. Microsoft Project Refresh  
Refresh a file imported from, or tagged to, a Mi-
crosoft Project or Microsoft Project server file or files. 
Build a refresh list for a Milestones files tagged to 
multiple Microsoft Project  or Microsoft Project Serv-
er files. 
Learn more about importing from Microsoft Project  
under Help | Help Topics. 

12. Printing 
Choose Printing Options to change the output size, print a specified date range, or exclude columns. 
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